Troubleshooting and Maintenance
Troubleshooting and Maintenance overview
Troubleshooting tools are especially useful when a device behaves erratically, a software program doesn't run properly, or when you just want to perform simple maintenance tasks on your computer. Because the underlying problem is often difficult to identify, Windows 2000 contains several troubleshooting and maintenance tools to help you either avoid or diagnose and repair a wide variety of problems. For example, when your computer keeps too many temporary files on your hard disk, you may start running out of space or programs may scan the disk more slowly.
The troubleshooting tools in Windows 2000 include:
Interactive troubleshooters
The Windows 2000 troubleshooters, available in the Windows 2000 online Help system, use a simple question-and-answer approach to problem solving. If you are not certain what is causing a problem, the troubleshooters are a good place to start. 
Error message support
Many common error messages now have a Help button attached to them, which gives you direct access to a Help topic that explains how to fix the problem. Also, the online Help documents over 70 common networking errors, providing you with descriptions and a possible solutions to the most common networking issues. 
The maintenance tools in Windows 2000 include:
Disk Cleanup wizard
The Disk Cleanup wizard can help eliminate performance and disk space problems. This tool guides you through a series of tasks and step-by-step procedures to help you get back to work quickly. 
Diagnostic utilities and features
Windows 2000 contains several utilities that can help you repair disk errors, defragment disk drives, identify and resolve device conflicts, update system files, and debug software. There are also several features to help you start or repair your system. 
Windows 2000 troubleshooters
The following troubleshooters are available on Windows 2000. You can start a troubleshooter by clicking the name that is highlighted in the left column of the table. 
Troubleshooter
Identifies and resolves problems related to:
Client Service for NetWare
Client Service for NetWare, including accessing NetWare servers and Novell Directory Services (NDS) objects, printing to NetWare printers, using NetWare login scripts, and logging onto an NDS tree.
Display
Video cards and display adapters, including your computer screen, outdated or incompatible video drivers, and incorrect settings for your video hardware.
Hardware
Cameras, CD-ROM drives, game controllers, hard drives, keyboards, mouse devices, network adapter cards, and scanners. If you are having problems with a sound card, a modem, or a display or video adapter card, this troubleshooter may help you, but you can also see the individual troubleshooters for those devices.
Internet connections (ISP)
Connecting and logging on to your Internet service provider (ISP).
Modem
Modem connections, setup, configuration, and detection.
MS-DOS programs
Running MS-DOS programs on Windows 2000.
Multimedia and games
Installing and configuring DirectX drivers and games. 
Networking (TCP/IP)
Internet and intranet connections that use Transmission Control Protocol/Internet Protocol (TCP/IP) on a computer running Windows 2000 Professional.
Print 
Network or local printers and plotters, including outdated or corrupted printer drivers, network and local printer connections, and printer configuration. 
Remote access
Network and dial-up connections that use a telephone to connect your computer to another computer.
Sound
Sound cards and speakers.
System setup
Installing and setting up Windows 2000.
Windows 3.x programs
Running 16-bit Windows programs on Windows 2000. If you are having problems running an MS-DOS program, see the MS-DOS troubleshooter.
To update your system files using Windows Update
 1.
Go to Windows Update at the Microsoft Web site (http://www.microsoft.com/). 
 2.
On the Windows Update home page, click Product Updates. 
Notes

You must be logged on as an administrator or a member of the Administators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Windows Update, click Start, and then click Windows Update. 

Windows Update is a catalog of items such as drivers, patches, help files, and Internet products that you can download to keep your computer up to date. 

Using the Product Updates section of Windows Update, you can scan your computer for outdated system files and automatically replace them with the most recent versions. 

Using Windows Update, you can check for the latest help files and download them to your computer. 

The first time you go to the Product Updates page, click Yes when prompted to install any required software or controls. 
To diagnose device problems 
 1.
Open Add/Remove Hardware in Control Panel. 
 2.
Click Next, click Add/Troubleshoot a device, and then click Next. Windows 2000 tries to detect new Plug and Play devices. 
 3.
Choose the device you want to diagnose and fix, and then click Next. 
 4.
Follow the instructions on the screen. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

If you cannot find the device in the list, click Add a new device, and then follow the instructions on the screen. 

You can also perform some diagnostic tasks, including repairing devices that are not working properly, using the Device Manager. This is recommended only for users who have an expert understanding of devices and device configurations. 

If you are not an administrator or a member of the Administrators group, you can use Run as to perform certain administrator functions. 
Detecting and repairing disk errors
You can use the Error-checking tool to check for file system errors and bad sectors on your hard disk.
 1.
Open My Computer, and select the local disk you want to check. 
 2.
On the File menu, click Properties. 
 3.
Click the Tools tab. 
 4.
Under Error-checking, click Check Now. 
 5.
Under Check disk options, select the Scan for and attempt recovery of bad sectors check box. 
Notes

To open My Computer, double-click My Computer on your desktop. 

All files must be closed for this process to run. If the volume is currently in use, a message asks if you want to reschedule the disk checking for the next time you restart your system. Then, the next time you restart your system, disk checking will run. Your volume will not be available to run other tasks while this process is running. 

If your volume is formatted as NTFS, Windows 2000 automatically logs all file transactions, replaces bad clusters automatically, and stores copies of key information for all files on the NTFS volume. 
To start Windows 2000 in safe mode
 1.
Click Options, and then click Print to print these instructions. They will not be available after you shut your computer down in step 2. 
 2.
Click Start, and then click Shut Down. 
 3.
Click Restart, and then click OK. 
 4.
When you see the message Please select the operating system to start, press F8. 
 5.
Use the arrow keys to highlight the appropriate safe mode option, and then press ENTER. 

NUM LOCK must be off before the arrow keys on the numeric keypad will function.
 6.
Use the arrow keys to highlight an operating system, and then press ENTER.
Notes

In safe mode, Windows 2000 uses only basic files and drivers (mouse, monitor, keyboard, mass storage, base video, default system services, and no network connections). You can choose the Safe Mode with Networking option, which loads all of the above files and drivers plus the essential services and drivers to start networking, or the Safe Mode with Command Prompt option, which is exactly the same as safe mode except that a command prompt is started instead of Windows 2000. You can also choose Last Known Good Configuration, which starts your computer using the registry information that Windows 2000 saved at the last shutdown. 

Safe mode helps you diagnose problems. If a symptom does not reappear when you start in safe mode, you can eliminate the default settings and minimum device drivers as possible causes. If a newly added device or a changed driver is causing problems, you can use safe mode to remove the device or reverse the change. 

There are circumstances where safe mode will not be able to help you, such as when Windows system files required to start the system are corrupted or damaged. In this case, the Emergency Repair Disk (ERD) may help you.
Using Disk Cleanup
Disk Cleanup helps free up space on your hard drive. Disk Cleanup searches your drive, and then shows you temporary files, Internet cache files, and unnecessary program files that you can safely delete. You can direct Disk Cleanup to delete some or all of those files.
Open Disk Cleanup.
Note

To open a system tools item, click Start, point to Programs, point to Accessories, point to System Tools, and then click the appropriate icon.
To compress an NTFS drive
 1.
Open My Computer, and then click the NTFS drive that you want to compress. 
 2.
On the File menu, click Properties. 
 3.
Select the Compress drive to save disk space check box. 
Notes

To open My Computer, double-click its icon on the desktop. 

Additional information on NTFS is available. If you are using Windows 2000 Professional, see the Windows 2000 Professional Getting Started online book. 
Using Backup
The Backup utility helps you create a copy of the data on your hard disk. In the event that the original data on your hard disk is accidentally erased or overwritten, or becomes inaccessible because of a hard disk malfunction, you can use the copy to restore your lost or damaged data.
Open Backup.
Notes

To open a system tools item, click Start, point to Programs, point to Accessories, point to System Tools, and then click the appropriate icon. 

You can also use the Backup utility to create an Emergency Repair Disk (ERD), which will help you repair your system. 

For information about using Backup, click the Help menu in Backup. 
To schedule a new task
 1.
Open Task Scheduler. 
 2.
Double-click Add Scheduled Task. 
 3.
Follow the instructions in the Scheduled Task wizard. 
Notes

To open Task Scheduler, click Start, point to Settings, click Control Panel, and then double-click Scheduled Tasks. 

If you want to configure advanced settings for the task, select the Open advanced properties for this task when I click Finish check box in the final page of the wizard. 

Confirm that the system date and time on your computer are accurate, as Task Scheduler relies on this information to run scheduled tasks. To verify or change this information, double-click the time indicator on the taskbar.
Using Disk Defragmenter
Disk Defragmenter rearranges files, programs, and unused space on your computer's hard disk, so that programs run faster and files open more quickly. Disk Defragmenter does not affect anything that you see on the screen, such as files in My Documents or shortcuts on the Programs menu.
Open Disk Defragmenter.
Notes

To open a system tools item, click Start, point to Programs, point to Accessories, point to System Tools, and then click the appropriate icon. 

For information about using Disk Defragmenter, click the Action menu in Disk Defragmenter, and then click Help. 
Using Power Options
You can reduce the power consumption of your computer devices or your entire system with Power Options. You do this by choosing a power scheme, which is a collection of settings that manages the power usage by your computer. You can create your own power schemes or use the ones provided with Windows 2000.
Open Power Options in Control Panel.
Notes

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

You should save your work before putting your computer on standby. While on standby, information in computer memory is not saved on your hard disk. If there is an interruption in power, information in memory is lost. 

To use Power Options, you must have a computer that supports these features. For more information, see your computer documentation. Which Power Options display will depend on your hardware configuration. 
Help for error messages
Windows 2000 provides troubleshooting information for some of the more commonly encountered system errors. This troubleshooting information will help you diagnose the problem and get back to work as quickly as possible. 
When you click Help in an error message dialog box, you will get the following information: 

A detailed description of the error. 

One or more ways in which you can resolve the error. 

A list of related tools and Help topics that may help you prevent the error from occurring in the future. 
